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Note

B2 . . .
Features marked by sign — are available for the Professional version only

Overview
SharePoint Scanner Plug-in 2010 is a powerful tool for scanning and composing documents from

existing images directly into a document library.
With easy-to-use interface of the Plug-in, your employees will be able to scan documents right
away allowing you to save on training your staff.
The Plug-in supports:
1. OCR allows to convert image to text ( more than 50 languages )* B
2. Properties recognition - Zonal OCR B **
3. Barcode recognition &
4. Scanning multiple documents in a single batch using document separator sheets or
barcode separation &
5. Saving pages as:
o Single document
o Document per page
o Multiple documents using document separator sheets &~
Document composing from the existing image or PDF files
Regular and Quick Scan modes

PDF, TIFF, JPEG, PNG, BMP and GIF output formats.

w ® N o

Advanced compression technologies enabling best document quality with smallest

file size

10. All types of Windows-compatible scanners: simple desktop and professional
scanners with feeders, local-connected (USB) and network-connected (IP) scanners.

11. All major browsers (Internet Explorer, Chrome, Firefox).

12. Multilingual user interface (English, Arabic, Czech, German, Hebrew, Russian)
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* Supported OCR languages: B

English, Afrikaans, Albanian, Arabic, Azerbaijani, Basque, Belarusian, Bengali, Bulgarian, Catalan,
Cherokee, Chinese Simplified, Chinese Traditional, Croatian, Czech, Danish, Dutch, Esperanto, Estonian,
Finnish, Frankish, French, Galician, German, Greek, Hebrew, Hindi, Hungarian, Icelandic, Indonesian,
Italian, Japanese, Kannada, Korean, Latvian, Lithuanian, Macedonian, Malay, Malayalam, Maltese,
Norwegian, Polish, Portuguese, Romanian, Russian, Serbian, Slovakian, Slovenian, Spanish, Swabhili,
Swedish, Tagalog, Tamil, Telugu, Thai, Turkish, Ukrainian, Vietnamese

** License for Zonal OCR Extension is required
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Picture 1

Scanner Plug-in has native integration with SharePoint Document Library Ribbon

Library Tools

Site Actions ~ @Y Browse Documents
\ts ” y
: C
NG R
0 = 1) & 2 5
New Scan Upload MNew Edit a

Document ~ Document » Document » Folder Document & [
New‘ Open &1
Libraries D\PW Mame

Site Pages - Nebsio Calend;

A

Shared Documents

Invoices g Add document

Picture 2

SharePoint Scanner Plug-in Client - The eDocStation

T
L. Websio eDocStation v. 4.0.1 ! = e
U =0
Home Images Properties Recognition

E - — | [¥] OCR q

: o English o
Save New Add Open = Settings

Document  Page(s) B & Change Language
Scan File System OCR Settings

Save options: [~| Save selected pages only [] Save each page as a separate document.

>

] Avw X

-5 = T

it A Bill TO:
i i PURCHASE =
Sestaeas Water Drinking Corporation
MName: Mr. Dolphin Shark ORDER
Page 1 Address: | GulfStream S
] AV X City, ST Zip: Atlantic Town 882254
) = Phone: | *+1(100)988-8333 B
= The following number must appear on all related
T = Correspondence, shipping papers, and invoices: Accounts payable contact:
rr— Phone:
SRS dolphin@gulfstream.at!
po. 89540 Email: phin@g
Vendor: (NOTE: Please only use info below) Ship To: (site to be shipped to)
Page 2 Hewlett-Packard Name :
Attn: State & Local / Higher Ed / K-12 Sales 4
10810 Farnam Dr. Companys
Omaha NE 68154 e
Voice: 1-800-888-3224
Fax: 1-800-825-2329 City, State ZIP :
Phone: -
< m ] »
Page 10f2
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Requirements

Server Requirements
e Microsoft SharePoint Server 2010 or Microsoft SharePoint Foundation 2010

Client Software Requirements
e Windows 7/8/10.

e Internet Explorer / Microsoft Edge / Chrome / Firefox

e Microsoft .NET Framework 4.0 +

Scanner Requirements

Local-connected and network-connected scanners have to be correctly defined on
the workstation. Usually it is enough to install correct scanner drivers. Please refer
to your scanner documentation.

To test that your scanner is correctly defined, try to scan from one of the standard

Microsoft programs like Paint or Microsoft Clip Organizer
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Installation

Server-side installation

1. Important! You must be logged on to the server by using an account that is a
member of the Administrators group and SharePoint Farm Administrators

2. Unzip directory "server" from the ScannerPlugin2010Pro.zip file on your SharePoint
2010 front-end server (WFE).

3. Important! Right-click the "setup.exe" and select "Run as Administrator" in order to
begin the plug-in installation wizard. Otherwise the error dialog box will alert you of
the error that has occurred:

jii Websio SharePoint Scanner Plug-in 2013 Professional |

There iz a problem with thiz Windows Installer package. & program required for this inztall
ko complete could ot be rin. Contact pour zupport personnel or package vendar,

Ok

4. Repeat previous steps on each your SharePoint WFE server.
5. After installation is complete, open top-level site of the site collection where you will

use the plug-in.
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6. Open "Site actions" menu and select option "Site Settings"

Browse

Edit Page
Edit the contents of this page.

_J Sync to SharePoint Workspace
S-? Create a synchronized copy of

this site on your computer.

New Page
Create a page you can L
customize.

| New Document Library
_D Create a place to store and
share documents.

New Site
@ Create a site for a team or
project.

More Options...
Create other types of pages,
lists, libraries, and sites.

= View All Site Content
{|  View all libraries and lists in
this site. £

Edit in SharePoint Designer
Create or edit lists, pages, and
workflows, or adjust settings.

A
Site Permissions
@ Give people access to this site.

Site Settings
Access all sattinm

T

R o T -

7. Select option "Site collection features'

Site Collection Administration
LLE'EI:_HJ Search settings
—=1 Search scopes
Search keywords
FAST Search keywords
FAST Search site prometion and demotion
FAST Search user context
Recycle bin
Site collection features

Site hierarchy
Site collection navigation

Site collection audit settings
Audit log reports

Portal site connection

Site collection policies
Storage Metrics

Content type publishing
Variations

ariation labels

Translatable columns
Variation logs

Suggested Content Browser Locations
SharePoint Designer Settings
Visual Upgrade

Help settings

8. In the list of installed features find "Websio Scanner Plug-in 2010 Professional" and

click on the button "Activate".
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System Account ~

J RERETEES Deactivate | Active
Creates reports about information in Microsoft ShareFoint Foundation. -

Site Actions -

= Search Server Web Parts
: Activate |

This feature uploads all web parts required for Search Cente

- SharePoint 2007 Workflows
r@ ) ) B ) . . Activate |
Aggregated set of out-of-box workflow features provided by SharePoint 2007
Deactivate |

SharePoint Server Enterprise Site Collection features

Features such as InfoPath Forms Services,
Excel Services Application, included in the Share

- SharePoint Server Publishing Infrastructure

!
[ Provides centralized libraries, content types, master pages and page layouts and Activate |

enables page scheduling and other publishing functionality for a site collection

SharePoint Server Standard Site Collection features

Ee -
[ Features such as user profiles and search, included in the SharePoint Server &I

Standard License

[ Three-state workflow "
I Deactivate | Active
J Use this workflow to track items in a list -

[F-+ | websio QuickLaunch 2010 JEEnEiE |
[ Websio Scanner Plug-in 2010 Professional &I .

.| Workfl
F@ oririows Deactivate |

Aggregated set of out-of-box workflow features provided by SharePoint

Special case: If your SharePoint Server uses Forms Authentication,

see section “Special Settings”.

Client-side installation

1. Unzip directory "eDocStation" from the ScannerPlugin2010Pro.zip file on your client
machine

2. Important! Right-click the "setup.exe" and select "Run as Administrator" in order to
begin the plug-in installation wizard.

3. Please pay attention! SharePoint Scanner Plug-in out of the box arrives with English
OCR language pack only. Download and install additional OCR language packs from

our site: http://www.websio.com/product.aspx?ID=128 ¥*

4. Windows Firewall alert may appear during installation. Approve network access for
eDocloader.exe. The eDocLoader does not access any external internet resources

and is responsible for communication with SharePoint only.
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When the installation has been completed successfully:

1. lcon of the eDocLoader appears in the system tray of the client workstations:

Customize...

Please, do not close the eDoclLoader. This program is responsible for communication

between client part of the Plug-in and SharePoint.

2. New button will appear in Files Ribbon:

Library Tools
Site Actions ~ @J  Browse Documents
& ﬂ : C
—— & o
MNew Scan Upload Mew Edit )
Document ~ Document ~ Document -~ Folder Document @& ¢
Mew Open &1
Libraries O Mame
2E BT -, Websio Calend;

Shared Documents

Invoices g Add document
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Trial version

You can switch between Standard and Professional modes during Trial period. Properties

recognition may be activated in the Professional mode. See section “Properties Recognition -

Zonal OCR” for details.

L. Websio eDocStation v. 4.0.1 - Trial Version

UM =aO

Home Images Trial mode

P S

Enable Properties Recognition
Professional | Standard O ¢ *

Trial Mode P Properties recognition P
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How to use

Regular Scan Mode

1. Open document library view, select tab "Documents" and click on the button "Scan

Document"

Library Tools

Site Actions ~ @ Browse Documents

) = 1) o

New Scan Upload Mew Edit
Document » Document>%Pocument » Folder Document
New Op

Libraries a Type Mame

Site Pages - Websio C
Shared Documents

Invoices g Add document

The eDocStation will be opened in the SharePoint Scanner Plug-in mode*.

| == = 3

BACWSE
"] Ve Dz Home  Images Praperties Recagnition
&= 5o Doaung u 7 R %
- . o
{1l upioss Doa Hew Open E.r5|..1. Setings
Document EL  Change Langquage k.
Scan File Synte= OCR Set¥ings

Huirss

Diocumpnts

Recent
Wtrsio §
Orders L

Pl Enif

FloonCa

Flicmirima
Demo Coou
tast
Clsinmers
Cubsitas

Hcs
Dem librar
Diem Do

Gile Cordes

# BT LIk

* The eDocStation can be used as a standalone application too. In this mode, documents are stored in the
file system. You can run the eDocStation in the standalone mode from Start Menu or from the desktop

shortcut.
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1. Click on the "New Document" button in order to scan new document

Home Images Trial mode
L OCR
New o - English Segc
en ings
Document Scan8tSave B EL Change Language ?
File System OCR Settings
Scan Parameters @
Source Qutput Type Resolution
Flatbed - Grayscale - 300 =
Show "Select scanner” dialog
|7l Do not show this dialog again
k
Please walt...
2. Select scanner
=8 Select Device =
Which device do you want to use?
HP LJ HP Officejet
M1271..  Pro 8500 AS...
Manufacturer:  Hewlett-Packard
Description: HP LJ M127128 Scan Drv
[ ok || Caneel |

* This step may be omitted by unchecking option "Show Select Scanner dialog" on the previous

screen or in the eDocStation settings
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3. Scanner-specific window will be opened. Complete scan process. *

— —— il sl
> HP TWAIN - HP Officejet Pro 8500 A910 (NET) . = 2 | b
A q A as
Select a shortcut, adjust settings, and click Scan.
sh Or, create a new shortcut, ht(s)

Gray Document

b 4

Color Document

Scan size:
44 (210 x 297 mm) -]
Gray Document Output type:
lGraysmIe ']
Black and White Document Resolution:
(300 dpi ~|

Photo

|| Show scan preview

[ 5can both sides (duplex)

Advanced Settings....
Create Mew Shortout. ..

Restore Defaults

Scan ] [ Cancel

* You can avoid this step by selecting WIA protocol in the eDocStation settings
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4. Scanned pages:

.. Websio eDocStation v. 4.1 - Trial Version e
M=
Home | Images Trial mode
b V] OCR
H > =t 2o %
e English
Save New Add Open Settings
Document  Page(s) & Change Language
| Scan File System OCR Settings
Save options: || Save selected pages only [] Save each page as a separate document.
T e PURCHASE i
o Water Drinking Corporation
e bass Name: Mr. Dolphin Shark ORDE R o
== Address: Gulf Stream 5
== Gity, ST Zip: Atlantic Town 882254
Phone: +1(100) 988-8333

The following number must appear on all related
Accounts payable contact:

1

Correspondence, shipping papers, and invoices:

Page 1
Phone:
o AV X in@gulfstream.at!
vio. | 89540 Emai; | 9Phine9
s —»:-__ Vendor: (NOTE: Please only use info below) Ship To: (site to be shipped to)
Hewlett-Packard Name:
= Attn: State & Local / Higher Ed / K-12 Sales i . 3
v 10810 Farnam Dr. mpany :
e Omaha NE 68154 Adiveiss
Voice: 1-800-888-3224
Fax: 1-800-825-2329 City, State ZIP :
Phone:
Page 2 eMail address:
P.0. DATE REQUISITIONER Contract name / Number F.0.B. POINT TERMS
free 30 days
Mo T oaww | DESCRIPTION [ unmerice | torac | -
< n »
Page 10f2

5. Click on the "Save" button, enter document name and select format.

Save to SharePoint

Mame:

_|PDOF ~]

ok | Cancel |

Select option "Always use auto name" in the eDocStation settings to avoid this step.

6. Created document will be saved in the SharePoint Document library.
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7. Standard SharePoint properties window will be shown if document profile contains

required properties

Invoices - test03.docx

HB8 0.0 X
‘j 53 Copy
Save Cancel Paste Delete

tem

Commit Clipboard Actions

Mame * test03

Title

Lang

|Enalish
My City Paris [=]

My Country France E|

Created at 8/28/2012 2:40 PM by Boris Yaroshevsky
Last modified at 8/28/2012 9:41 PM by Boris Yaroshevsky
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Additional save options:

1. Save selected pages only:
[ ]

e Select pages

e Click on the button “Save”

Select checkbox “Save selected pages only”

( %, Websio eDocStation v. 40.1 - = 8] R
=D
Home | Images Properties Recognition
~ ¥] OCR

‘ H ;> % English fo

Save oW Sabti

Document  Page(s) EP# &1 Change Language g

‘ Scan File System OCR Settings

Save opticns. || Save pages only | Save each page as a separate document.

9 AY X \ ]
= s i
e Bill TO:

[ water Drinking Corporation PURCH/:
v W Dolphin Shark ORL
Page 1 Address: Gulf Stream 5
= Av X Gy, ST Zip: | Atlantic Town 882254
- +1(100) 988-8333
— The following number must appear on all related
e — Correspondence, shipping papers, and invoices: Accounts payable contact:
i Phone:
- dolphin@guifstream atl
r.o.ml 89540 Emait:
= Vendor: (NOTE: Please only use info below) Ship To: (site to be shipped to)
Page 2 Hewlett-Packard Name:
Attn: State & Local / Migher Ed / K-12 Sales
g Av X 10810 Farnam Or. G
‘ Omaha NE 68154 Address :
Voice: 1-800-888-3224

o= B Fax: 1-800-825-2329 City, State ZIP :
= Phone: ¥
, n | )

s Page 10f3
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2. You can save each page as a separate document:

[

L. Websic eDocStation v. 4.0.1

M=
Home Images Properties Recognition
- - OCR O
- English i
Save Mew Add Open - Settings
Document  Pagels) &4 Change Language
Scan File System OCH Settings

Save options: Save selected pages onhy = e each page as a separate document.

S

Aw X
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Quick Scan Mode

1. Select option "Quick Scan" from the drop-down menu.

|;| http://sps2010clear/Shared%200acuments/F O ~ C X | |;| Shared Docurments - All Da...

Library Tools
Site Actions - @Y  Browse Documents
e ﬂ. : Check Qut Versi
S ] ) ;
* 3 Check In [ 3o Do
ew can Upload MNew Edit View Edit
Document - |Document | Document - Folder Document & Discard Check Qut  Properties Properties ¢ Dele
Regular Scan n & Check Cut Manage
. . _: Scan or create document(s) from
Libraries existing images
£liz ErE= — Quick Scan :ndar Web Part- upgrade to version for SharePoint

Shared Do = = Quick Scan & Save document

Invoices B Add document

2. New document(s) will be scanned and saved automatically. The eDocStation window
will not be displayed.

3. Document names will be generated automatically using prefix defined in the Quick Scan
settings (see paragraph "Settings").

4. To save each page as a separate document in the Quick Scan mode, select option
"Create document per page" in the eDocStation Quick Scan settings

Settings &

Global I PDFand OCR Quick Scan | Barcode I Scan Settings | License and Version

¥ Create de

File name prefix

[” Always use auto-name

Save documents to directory:

I Browse |

0K Cancel
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Document Separator Sheets P
A separator sheet allows the scan application to detect when a new document should be

started. It helps the scan operators to increase productivity and organize a stack of paper into

logical documents. That eliminates the need for individually scan of each document either.

1. Select option "Use Document Separator Sheets" in the eDocStation settings
2. Print Document Separator Sheet:
a. Open Document Separator Sheet from the "Start->All Programs -> Websio

eDocStation"

; WCF RIA Services V1.0 5P1 I
; Websio eDocStation
Eﬂ Document Separator |

L. eDocStation
L Windows Virtual PC il
; WinRAR -

1 Back

or from the eDocStation installation folder

» Computer » Data (C:) » Program Files (x86) » Websio Information Solutions » eDocStation » - |¢¢|[

Organize « P8 Open with Adobe Readerd Print Mew folder

¢ Favorites Mame Date modified Type
Bl Desktop s 12/10/2012 19:22 File folder
4. Downloads L de 12/10/201219:22 File folder
| Recent Places | ocr 12/10/2012 19:22 File folder
[Z] SharePaint Sites K ru 12/10/2012 19:22 File folder
& SkyDrive . ru-RU 12/10/2012 19:22 File folder
. Settings 12/10/201219:22 File folder
- Libraries . Temporary 12/10/2012 19:33 File folder
5 Documents [5°1] eDocStation.exe 12/10/2012 01:39 Application
J‘i Music [—-_'ﬁ eDocStation_separator.pdf ] 11/10/2012 19:07 Adobe Acrobat D...
[=] Pictures =1 edocStationCompleter.exe 07/10/2012 12:51 Application
ﬂ Widanr N i LUl AT AN LN T e e
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5 open | &) B2 | [t ]ra|][ % [+] &® = Tools | Fill & Sign |

L =DocStstion_separator pdf - Adobe Resder = |BE &
File Edit View Window Help =
Commecnt

[ ]

eDeocStation Document Separator

hitp:/ ferara vehsio_ com

850 x11.00 in 4| m

b. Print Separator Sheet in A4 format in a high quality.

3. Separate documents in the scanner feeder by previously printed sheets

4. Scan documents using SharePoint Scanner Plug-in. Quick Scan mode is recommended

but not required.

Websio Information Solutions Ltd

http://www.websio.com sales: sales@websio.com support: support@websio.com



http://www.websio.com/
mailto:sales@websio.com
mailto:support@websio.com

\ Solutions for information workers

OCR - convert images to searchable PDF P

Searchable PDF (document created using OCR process) advantages:
a. Search documents by content using standard SharePoint or FAST search
engines

b. Search text in the document:

2 demo.pdf - Adobe Reader.

File ~Ed foofs Window Heip

it View Docurment
= B AR 2 /2 ® ® 209% - o (4 Project SE

PROJECT NUMBER AND SITE

1. Send request to IT PMO for jifaject number and project site.

2. The PMO will open the project in Hilan s’ reporting.

3. The PMO will open a SharePoint site for the Pepject, where you will store all
documentation and data related for the project,
ECINET> EQ Portal> IT> IT Workbench> IT Portal PMT> Domain> Project nome

c. Copy text from the document:

:j-v- -0 X
le Edit View Document Toc Window  Help x
& E e 2200w [ G e - (@90l Document3 ® s or W
3T PO il Gpan 3 SRarepoint st or the profect, where you Wil store sl | Home | Inset  Pagelayout  References  Mailngs  Review  View
Secumabaetion et rletil e che peciect 0 4 ArialUnicodeMs e - (= Al
g B I U-aex x &
GANTT Paste 7| B A AN Paragraph Styles | Editing Sales Force
4 Mul:m MS Project 2007 your computer Clipboard Font
5 M:::L”Mww E”-‘é TR S O YR SO P O N S 207 P O O RS KB AR ¥ PR RS ¥ KR T O -
File> New> On Computer> Enterprise templates> =
6. Save file with naming convention: T~ PROIECT NAME
7. Define start date of the Project: i
Project> Project Information> Start date =
& sovf| |~
5. s o milestone Il _ _ B
Window> Spli & 2 : Manage Risks in the SharePointsite, in the risks List:
10, After you projects nd made Save & roject Site: Risks
b peks Setatnal | B. Create mitigation plans for each risk and follow-up on them. In order to
u'““' g S Baseime _— educe the impact or probability of the risk.
dagesfor tasis; . Update the Risks list with changes to probability and/or impact of risks on a

12, Before Project review check yourself by using “Agenda Form> Need Update” view. eekly

15. Owlng! 2 % “Agenda Form> Tracking ’/
>

Ll [ [T ]
Page:1ofl | Words:53 | B Engish(us) | 71 | B8R = = 100% (o) U
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The best OCR (text recognition) quality can be reached for images scanned in

grayscale with 300 dpi resolution.

1. Select checkbox "OCR" and document languages to create searchable document.

L Websic eDocStation v. 4.5.3 - Trial Versicn

M=dig
Home Images Trial mode
E — é : "
: English
Save New Add Quick Cpen - Settings
Document  Page(s) | ScanfiSave &3 Change Language

Scan File System OCR Settings
Save options: [ Save selected pages only [7] Save each page as a separate document.

Important! Use secondary language when it is necessary - your documents have
bi-lingual content. Best OCR results may be achieved by using single language.

i '

& Select OCR Language = | = z3

Primary OCR language
|Engiish -l

v Use secondary language

Don't use secondary language if it's not
really necessary. Best OCR results may be
achieved by using one language.

|Czeu:h ﬂ

oK Cancel |

Y.

Websio Information Solutions Ltd
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/ /

Information Solutions

Set default OCR parameters using eDocStation settings:

Settings

Global PDFand OCR | Quick Scan ] Barcode ] Scan Settings ] License and Version

v Optimize images for recognition

W UseOCR
Primary OCR Language v |se secondary language
English j |Czec:h ﬂ

OK Cancel

Important! SharePoint Scanner Plug-in out of the box arrives with English OCR
language pack only. Download and install additional OCR language packs from our
site: http://www.websio.com/product.aspx?ID=128

2. OCR process runs during document save process. The process may take some
time, depending on the pages count and original images quality.

3. OCRis available for all scan modes: Regular Scan, Quick Scan and Document per

page mode.

Websio Information Solutions Ltd
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Solutions for information workers

Properties Recognition - Zonal OCR P

License for Zonal OCR Extension is required

This feature enables automatic properties recognition and assignment.
Demo videos:

1. Part1l-Overview.

2. Part2-Templates

Examples.

Task: scan order, recognize Order ID, Customer and Amount, save document to
SharePoint and assign recognized values to document properties.

Destination document library properties:

Columns

A column stores information about each document in the document library. The followi

Column (dick to edit) Type

Title Single line of text
Order ID Single line of text
Customer Single line of text
Amount Currency

Created Date and Time
Modified Date and Time
Created By Person or Group
Modified By Person or Group
Checked Out To Person or Group

Important! Zonal OCR supports text, number and currency field types only.

Websio Information Solutions Ltd
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Example 1. Manual recognition

1. Scan document, open tab “Properties Recognition” (1) and click on the “New
(2). Document properties pane (3) will be displayed. The pane contains
supported properties from the current library.

2.

Solutions for information workers

2

. Websio «DocStation v. 400

M=

New Losd  Recent
Tevpiate

Home  Images 9vnn—rﬁes?\»(ognﬂon"_“

Save Ackd

Archor
Common

Water Driaking Corprration

Mr. Dolphin Shark

Gulf Stream &

Cay, 572 | Ada0t Town

[ 2254

+1(100) 9888333

The folowing number must anpear on al related

PURCHASE

ORDER

Corrmpondance, shipping papers,

e

Vendon: (NOTE: Please cnly use info below)

Hewlert
Astn: State & Local / Higher £d / K12 Sales
10830 Farnam Or.

Phone:

dolphin@guifitream.atl

Ship To: (site to be shipped to)

Name |

v
Page 1011

Document Properties
i1 oo
H ] o
[H Smﬂm_i

Click on the arrow or drag property to the scanned image surface.

Document Properties

|E Save and close | | E3 Cancel |

Order 1D

~—
EI Customer

Amourt

Websio Information Solutions Ltd
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3. Drag and resize property placeholder to fit actual text on the picture

-
: :
Customer . M| x

Bill TO:

Water Drinking Corporation

Mr. Dolphin Shark

Gulf Stream §

Atlantic Town 882254
+1(100) 988-8333

4. Recognized text appears on the Properties Pane under property name. Edit value
if necessary.

| = ) 18 % Document Properties
- LM | ¥
Bl Save and close | | B Cancel
es Recognition - Order ID
Save Add Cusomer X
As b Anchor i Water Denlong Comaration
5 mon ¥
ﬂ Amourt \
"
BillTO: = . 2
2 — = PURCHASE 13
namel[ 1] Cotoner ][] ORDER s
Address: Gulf Stream S
iy, 572 | At Town luns‘
" : +1(100) 988-8333

Websio Information Solutions Ltd
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5. Add and position other properties. Click “Save and close”

STle] %) Document Properties
3 | bl Saveaﬂodaaelluﬂmcdl
o35 Recognition oD E
JCE 3
LSﬂ :i‘: i Customer X
As ~ s R‘:‘nﬂ'ﬂr Water Dmkna Coplontiy
. Amourt E]
z 500
“'0: L} - .
& E Water Drinking Corporation j PURCHASE £
- - [x1 ORDER
Address: Gulf Stream 5
Atlantic T o b
Oy, ST2p: own I fosaase 1
Phone: +1(100) 988-8333 D Order 10 . .

The followsng number must appear on all related
Correspondence, shipping papers, and invoices: Accounts payable contact:

Phone:

6. You’'ll see the new button on the page thumbnail:

.. Websio eDocStation v. 4.0.0

‘| =S
| Home | Images Properties Recognit
H o> =
Save Mew Add Open
Document Page(s)
Scan File Systerr

Save options: [| Save selected pages only |

mhkvix -

Bill TO

Bus

'

= 4

Page 1 Gity, ¢

[ AW X - P

Websio Information Solutions Ltd
http://www.websio.com sales: sales@websio.com support: support@websio.com



http://www.websio.com/
mailto:sales@websio.com
mailto:support@websio.com

\ Solutions for information workers

7. Use this button to review and edit page properties values

%> Websio eDocStation v. 4.0.0

U=
Home Images Properties Recognition
K V| CCR
b > of borss
Englich
Save New Add Open = Settings
Document  Paqe(s) & Change Language
S(ar - —sy
opt % Page P g o @8 ®”
P Sovt 'age Properties
— — Property Name Proparty Value 1
Y m' X » Order 1D 882254
= Customer Water Denking Comporation
Amourt 500
PI
Page 1
T AV X
CEXTS -3
e — = -
] Vendor: (NOTE: Please only use info below) Ship To: (site to be shipped to)
I

8. Save document. Result:

Orders - order 1.pdf

e

4 Cut

53 Copy

X

Delete
Item

H B

Save Cancel

Paste

Commit Clipboard Actions

Mame *

Title

|Dr|:|er 1

Order ID
Customer

Amount

[8a540

|Water Drinking Corporation

http://www.websio.com
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Example 2. Templates
How to create template

1. Scan document and position placeholders as described in the previous example.

2. Add anchor. Anchor stores position of the selected text and text itself. When you
apply template for the document, the eDocStation searches for the anchor's text
and corrects position of the fields. Try to find unique single word or short
phrase for anchors. Add two anchors for the best positioning.

mv. 401 —

5 Properties Recognition

0
(4
icent Save Add

- As Anchor
nplate I Commen T

LA

Bill TO:

Water Drinking Eorpontion i

Name-l |:| Customer El

. | Gulf Stream 5

= : | Atlantic Town 882254

+1(100) 988-8333

Phone:
" s
Corresnnondance sh

aning papers, and invoices:

Accounts payable contact:
Phone:

- U MW

Vendor: (NJ D Order ID El Ship To: (site to be shipped to)

Websio Information Solutions Ltd
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Document Properties

2| |H Save and close | | Ed Cancel
| Order D
25540
Customer

Water Drinking Comaration

Amourt
1| 500
i oI Anchar

The fallnwini number

1 - Button “Add Anchor”
2 - Anchor placeholder
3 - Anchor’s text

3. Save template. You can select one of the following templates storages:
a. Personal —template available on this workstation only
b. Document library — available for the current library only
c. Site collection - available for all libraries in the current site-collection

Websio Information Solutions Ltd
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| Home Images Properties Recognition

Z

MNew Load Recent

-

A

Template

AW X

Page 1

N7

-

http://www.websio.com sales: sales@websio.com support: support@websio.com

Save Add
As Anchor
T Common I
|1
ol OCR Templates =1 I =
Mame Source Comments
.4 order] Personal 123
Crder Template Personal Template for order recognition
order local Personal Local template
order12 Document Library | 123 IRC
Template Name Templates Storage L
Document Lib -
Comment K —
[ ok |[ Cance
—
\ = 4
| —— Eompanv: |

Websio Information Solutions Ltd
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How to use previously saved template

1. Scan or load the image you have previously saved
2. Press on the button “Load” (1) or use one of recently used templates (2)

3. Select template

Home Images Properties Recognition

vl 3

s

New | Load Recent

‘_ Tel_e (] Common =

AW X |

a5l OCR Templates

[ = 2

= = E1  Delete
== — Name Source Comments
I order] Personal 123
i . Crder Template Personal Template for order recognition
3 order local Personal Local template

Page 1 e

[ ok ][ cancel

Cav 1.90AATE.3374

Websio Information Solutions Ltd
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4. The template will be loaded and placeholders will be positioned automatically
Adjust placeholders positions and/or edit properties values if necessary.

Please pay attention, the eDocStation displays only properties saved in the template. If
you want to add properties from the current library but not stored in the template, use

button “Show all properties”

. Websic eDocStation v. 40,1

1= = g
Home Images Properties Recognition
[P HHM ©E
New | Load Recent Save Save Show all Add
- As properties  Anchor
Template P on P

AW X \

£

Water Dﬂnking-Corporaﬁon ]

AT e (1]

T | Gulf Stream 5
r

[>]
g

Page 1
L ]

5. Save properties and save document as described in the “Example 1. Manual

Properties Recognition”.
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Barcodes P

The eDocStation supports out-of-the-box Code 128 barcode recognition. If you need to
recognize another barcode types (QR, Planet, etc.), please write to
support@websio.com

Define barcode recognition settings using Barcode tab of the Settings window.

r R
Settings 23
| Global | PDF and OCR | Quick Scan | Barcode | Scan Settings | License and Version |
o » V]| Recognize Barcodes
Barcode Value:
o »{"| Separate pages using barcode Do nothing v ¢
Page without barcode:
Add to previous document
° > Define Barcode Zones J
[ ok |[ Cancal |
L S > 5

Turn barcode recognition on

Select checkbox “Recognize barcodes” (1)

Separate pages using barcodes

Barcode-based pages separation allows the scan application to detect when a new document

should be started. It helps the scan operators to increase productivity, allowing them to

organize a stack of paper into logical documents. That eliminates the need to scan each

document separately.

Select checkbox (2) to activate this option.

You can select behavior for pages without barcodes using option “Page without barcode” (4):
1. Add to previous document

2. Save as a separate document

Websio Information Solutions Ltd
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Barcode Value:

You can save recognized barcode value to the SharePoint document property.

1.

Define property for barcode value in the destination SharePoint library. For example,

“Document Barcode”:

Site Adtions ~  § Browse Documents Library

"

Company » Scanned Documents » All Documents - * |
ILike It Tags
MNote
Company Search this site... pel
Pictures 0 Type MName Modified l Document Barcode l
My Pictures

There are no items to show in this view of the "Scanned Documents™ document library. To add a new item, dick "™Mew™ or "Upload™.

. . 4 Add document
Libraries

Site Pages

L I P

Open the eDocStation settings and set field “Barcode Value”(3) to “Save to SharePoint
Property”. Field “SharePoint Property” (6) will be displayed.

Set “SharePoint Property” (6) value to the name of the previously created SharePoint

property.
r N
Settings X4
| Global | PDF and OCR | Quick Scan | Barcode | Scan Settings | License and Version
[¥] Recognize Barcodes
Barcode Value:
[T] Separate pages using barcode Save to SharePoint property v « o
Page without barcode: SharePoint Property
Add to previous document - Document Barcode < o
Define Barcode Zones ]
oK |[ cancel |
- J

Websio Information Solutions Ltd
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4. Scan or create new document from existing image(s)

L. Websio eDocStation v. 40.1 - Trial Version (=@ =]
o=t
‘ Home ‘ Images Trial mode
[ -
:! OCR q
‘ E “:> L :glish o
Save New Add | Open 2% Settings
Document Pagefs) | & Change Language
‘ Scan File System OCR Settings
Save options: [| Save selected pages only [] Save each page as a separate document.
= = SUDJeCt: Teview. cense -
- SharePoint Document Preview
T B # | Name Licenses | Item Price (US$) | Total ( USS$)
count
(] AW X 1 Document Preview - Global license (for unlimited 1 $4,900.00 $4,900.00

number of SharePoint servers in the same —
organization domain).

— http://websio.com/product.aspx?10=133
5 2 Standard Support Program for Document Preview | 1 $735.00 $735.00
—_— http://www.websio.com/support.aspx

== Sub-total: $5,635.00
Zh Reseller Discount -$845.00
Total: $4,790.00
P 3 Conditions:
AV X 1. The license is domain-based (for unlimited number of SharePoint servers in the same organization
domain).

oo 2. Trial-version activator will be sent by e-mail in two working days after the payment will be received
and approved. L

| NN ~— -

Page 3 of 3

5. The Plug-in saves barcode value as a SharePoint property:

./
¢ » Scanned Documents *» All Documents = IL.;/
1Ke

Search this site...

[] & Type Name Modified Document Barcode

b5 demo I HEW 17.06.2013 17:08 [ 5646;39;1490901293121 ]

4k Add document

Websio Information Solutions Ltd
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Barcode Zones

Barcode recognition on the entire page surface is a time-consuming process. The best way to
reduce barcode recognition time is to define barcode zones.

Barcode zone is a rectangle where the eDocStation looks for the barcode. You can define as
many barcode zones as you wish. Of course, reducing count of barcode zones will reduce
barcode recognition time.

Important rules:
1. When barcode zones are not defined, the eDocStation looks for barcode on the entire

page
2. When one or more barcode zones are defined, the eDocStation looks for barcode in the
barcode zones only.

How to define barcode zones:

1. Load page containing barcode

L. Websio eDocStation v. 4.0.1 - Trial Version

=t
Home Images Trial mode
- OCR
English
Save New Add Open Settings
Document  Pagels) &4 Change Language
Scan File System OCR Settings

Save options: [ Save selected pages only [] Save each page a= a separate document.
B Np://Websio.com/product.aspx?ID=133
v X 2 | Standard Support Program for Document Preview | 1 $735.00
http://www.websio.com/support.aspx
- | Sub-total:

==, | Reseller Discount
| Total:

——— Conditions:

I
1. The license is domain-based (for unlimited number of SharePoint servers ir
—— domain).
P 1 : ; : -
age 2. Trial-version activator will be sent by e-mail in two working days after the

and approved.

W
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2. Go to Settings -> Barcode and click on the “Define barcode zones”

)=, Websic eDocStation v. 4.0.1 - Trial Version

Document  Page(s)

M=

Home | Images  Trial mode
OCR

" = . Zo
English

Save New Add Open Settings

@ Changelanguage

Scan File System OCR Settings
Sawe options: || Save selected pages only [F] Save each page as a separate document.
11 8 T TG T 3T T T
AY X Settings L= e
] - | Giobal | PDF and OCR | Quick Scan | Barcode | Scan Settings | CRM & SharePoint | License and Version | =
-3
Recognize Barcodes ]
Barcode Value:
7] Separate pages using barcode Do nothing -
Page without barcode:
[ame ¢
Add to previaus document
nt wil
Define Barcode Zones
G

I value 1

Settings window will disappear, new tab “Zones” will be displayed. Existing zones will be
shown on the image surface.

.., Websio eDocStation v. 4.0.1 - Trial Version

M=

Home Barcode Zones Trial mode
/ H B8
Create  Save (cancel
Zone Zones
Barcode Zones !
number of SharePoint servers in the same
AV :
X organization domain).
o http: bsio.com/product.aspx?1D=133
psires 2 Standard Support Program for Document Preview | 1 $735.00
=3 http://www.websio.com/support.aspx
= T Sub-total:
=== - Reseller Discount
— Total:
L]
Conditions:
Page 1 The license is domain-based (for unlimited number of SharePoint servers
domain).

Trial-version activator will be sent by e-mail in two working days after th:
and approved.

I
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4. Create new zone:
e Click on the button “Create Zone”

|
Home ‘ Barcode Zones |

e Zone selector will be added to the top-left corner of the image surface

‘- Websio eDocStation v. 4.0.1 - Trial Version
M=

Home | Barcode Zones | Trial mode

Creste  Save Cancel

Zone  Fones
Barcode fones (=

4% X

—— . % W

e — e r - @ '\
e Rt P— Solutions
—._.__. e — [ Test ][ Delete ]

[F1F 0 -

Quote #EV0672/1
Page 1 Date: May 21, 2014

o EmEw mi -

Websio Information Solutions Ltd
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e Drag zone selector to the barcode on the page and resize it as required.

)., Websio eDocStation v. 4.0.1 - Trial Version

=g
Home | Barcode Zones ‘
; Create Save (Cancel

|  Zone Zones
Barcode Zones 7

Trial mode

: 2 Standard Support Program for Document Preview | 1 735.00
AV X http://www.websio.com/s rt.aspx :
- s Sub-total:
Reseller Discount
Total:

{1}

Add additional zone selectors (if required) and press the button “Save Zones”

. Websioc eDocStation v. 4.0.1 - Triz
M=
Home | Barcode Zones |
Create | Save Gemed

Zone | fones
Barcode fones (=

Websio Information Solutions Ltd
http://www.websio.com sales: sales@websio.com support: support@websio.com
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Information Sciutions

User Interface

Please pay attention: there are some differences in the user interface for SharePoint-mode and
standalone mode. This document describes SharePoint-mode only. See the eDocStation User Guide for
further details. You can find it on the eDocStation page on our site:
http.//www.websio.com/product.aspx?ID=122

Main view. Tab “Home”

A o e nv.

H¢me nages
r

o
T

Vendor: (NOTE: Please only use info below)

Ship To: (site to be shipped to)

A
+ OCR
H < = English a
- glis|
Save New Add Quick Open - Settings
Document Page(s) | Scan&Save &2 Change Language
o_ Scan File System OCR Settings
m Save selected pages only Ej Save each page as a separate document.

Q= '

T = Bill TO:

Bk Water Drinking Corporation PU RC HASE E
[ 12 - o [ e i s ORDER
Address: Gulf Stream 5
Atlantic Town 2
Gity, ST Zip: ta ow! 882254
°/ > [ +1 0000888333 I
The following number must appear on all related
,: - Correspondence, shipping papers, and invoices: Accounts payable contact:
——— = Phone:
- = : dolphin@gulfstream.atl
b.0. NuMBER: | 9540 | E-maik &

Poge 2 Hewlett-Packard Name::
Attn: State & Local / Higher Ed / K-12 Sales Z
10810 Farnam Dr. P
Omaha NE 68154 Address :
Voice: 1-800-888-3224
Fax: 1-800-825-2329 City, State ZIP :
Phone: -
1 n ‘ )
» Page 10f2
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Information Solutions

New Document. Use this button to scan new document.

Add Page(s). Scan pages and add them to the current page set
Quick Scan & Save. Available in Standalone mode only.

Open. Add pages from existing image files from the file system.
Save. Save the document(s).

OCR. Select OCR checkbox to use text recognition process. £~
Settings.

Current page number and total pages count

£ ® N o U~ W N PR

Move page up.

[EY
o

. Move page down.

=
=

. Delete page

[Eny
N

. Page selector.

[Eny
w

. Page thumbnail

H
S

. Main view

[Eny
ul

. Save selected pages only. Select this option to create document from selected pages only.

=
[e)]

. Save each page as a separate document.

=
~

. Button “View page properties”. See section “Properties Recognition” for details.
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Thumbnails zone displays up 30 thumbnails. When pages count exceeds 30 pages, buttons

“Previous pages” and “Next pages” appear.

& Previous

Page 38
il Av X
Scaled-up and scaled-out t
You can estimate the performance of your starting-point topd
to the starting-point topologies that are provided in Doing sof
whether you must scale up or scale out your starting-point t
and capacity goals,

M = LY

To increase the capacity and performance of one of the starnt
one of two things. You can either scale up by increasing the
computers or scale out by adding additional servers to the
general performance characteristics of several scaled-out to,
represent the following commaon ways to scale out a
scenario:

Page s3

o To provide for more user load, add Web server co

e To provide for more data load, add capacity to the
the capacity of a single (clustered or mirrored) servedqc
servers.,

e Maintain a ratio of no more than eight Web server ©
mirrored) database server computer, Although test
optimum ratio of Web servers to database servers |
more robust hardware, especially for the database
your environment.

Estimating throughput tar

Websio Information Solutions Ltd
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Tab “Images”

)., Websio eDocStation v. 3.0.0 - Trial Version (=8| =
= =

Hone ’ Images ‘

v v v

4 N!t * ? [ S

Previous Clear Rotate | Delete
Page Page
Navigation All Pages Current Page

>

2 Previous pages

Page s8
Av X

Scaled-up and scaled-out tg|
You can estimate the performance of your starting-point topﬂEgl

to the starting-point topologies that are provided in Doing so gal—
whether vou must scale uo or scale out vour starting-point to

Navigation buttons
Clear. Delete all pages.
Rotate image.

Zoom

LA A

Delete current page
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Tab “Properties Recognition”

~. Websio eDocStation v. 4.0.1

M=

Home Images | Properties Recognition |

4 7 3
Mew Load Recent

-

Terplate = Common [l

[= e — 4 I

See section “Properties Recognition” for details.

Quick Access Toolbar

.
A, Websio elpocStdtion v. 4.0.1 - Trial Version

> M=k O
Home Barcode Zones Trial mode
. — [F] OCR
H O = .
English
Save New Add Open :
Document Paaels) 8

Save.
Scan new document.

Add page(s). Scan new pages and add them to the current page set

bl S

Open. Add pages from existing image files, stored in the file system.
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Information Sciutions
Settings
Global
(Settings 2 )
Global | PDF and OCR | Quick Scan | Barcode | Scan Settings | License and Version
Default output file format
o = :
User interface language
o Default -
° [] Use Document Separator Sheets
[ ok || cancel |
. vy

1. Default output file format. The following formats are supported: PDF, TIFF, JPG, GIF,
PNG or BMP

2. User interface language. English, German, Czech, Russian, Arabic and Hebrew languages
are available.

3. Use Document Separator Sheets. See section "Document Separator Sheets" above. &
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PDF and OCR P

1.

-
Settings =

Global | PDF and OCR | Quick Scan | Barcode | Scan Settings | License and Version

[¥] Optimize images for recognition

v

? [¥] Use OCR
Primary OCR Language [¥] Use secondary language <
»  English v Czech v <

Lok J[ Concel |

Optimize image for recognition. The eDocStation runs deskew and additional
optimization algorithms before OCR recognition. If you don’t use OCR or your source
images are in greyscale and clear enough, unselect this option to speed up document
composing process.

Use OCR — enable/disable OCR.

Default OCR languages.

Important! Use secondary language when it is necessary - your documents have bi-
lingual content. Best OCR results may be achieved by using single language.

Please pay attention: SharePoint Scanner Plug-in out of the box arrives with

English OCR language pack only. Download and install additional OCR language

packs from our site: http://www.websio.com/product.aspx?ID=128
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Quick Scan

-

Settings X4

| Global | PDF and OCR | Quick Scan | Barcode | Scan Settings | License and Version
[7] Create document per page

File name prefix

invoice [] Aways use auto-name <

Save documents to directory:

C:\share

1. Create document per page in the Quick Scan mode.

2. Prefix for auto-generated file name.

3. Destination directory for Quick Scan. Used by the eDocStation in the standalone mode
only.

4. Always use auto-name. Select this option to use automatic name in the Regular mode

either. When this option is selected, “document name” will be given automatically.
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Barcode P

-

Settings |

| Global | PDF and OCR | Quick Scan | Barcode | Scan Settings | License and Version

Recognize Barcodes

Barcode Value:
[C] Separate pages using barcods Do nathing

Fage without barcode:

Add to previous document

Diefine Barcode fones ]

0K || Cancel

See section “Barcodes” above
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Scan Settings

-
Settings

pXS

| Global | PDF and OCR | Quick Scan | Barcode | Scan Settings | CRM & SharePoint | License and Version |

Scan Protocol
> WIA - Show "Select scanner” dialog
. Source

Flatbed -

» [¥] Show parameters dialog

1. Scan protocol. TWAIN or WIA. Default value: WIA.

2. Show “Select Scanner” dialog. Select this option to select source scanner before
scanning.

3. This group of options is available for WIA only.

When TWAIN protocol is selected, the eDocStation displays scanner-dependent dialog

before scanning process. You can control paper source, resolution and other options

from this dialog. Full set of available options depends on the software supplied with

your scanner.

Source. Scan from flatbed glass or feeder.

Show parameters dialog before scan

Output type. Color, Grayscale or Black & White

N o v A

Image resolution
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Special Settings

Settings %

| Global | PDF and OCR | Quick Scan | Barcode | Scan Settings | CRM & SharePoint | License and Version |

My SharePoint Server uses Forms Authentication

Dynamics CRM Discovery Service

@ CRM on-premises
) Microsoft CRM Cnline or Intemet Facing Deployment

[ ok || Cancel |

L. "

If your SharePoint server uses Forms Authentication, select “My SharePoint uses Forms
Authentication”. If you are not sure which authentication model is in use on your
SharePoint, leave this checkbox unchecked.
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Troubleshooting

Error message "Problem with installation package" appears during
installation process

jii Websio SharePoint Scanner Plug-in 2013 Professional

There iz a problem with this \windows Installer packaage. & program required for this install
to complete could nat be rwn. Contact your support personnel or package vendar.

ok

Solution:

Right-click on the "setup.exe" and select "Run as Administrator" in order to begin the
installation process.

Button "Scan document"” does not appear

1. Open top-level site of the site collection where you are going to use the plug-in.

2. Open "Site actions" menu and select option "Site Settings "
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Library Tools .
. 5 . WEBSIO2010\Administrator ~
ite Actions ~| @Y  Browse Documents
—pn, | Edit Page A i E-mail a Link 1~ 3 ;)
} Maodify the web parts on this = ; : : ] ( /] o
3 e 4 i - W
page. ] L a; = mE]
View Edit Download a Warkflows Publish Ilike Tags &
= Mew Page |t Properties Properties )-(_ opy 1 _1 It Jotes
Create a page you can ~ . . s . ~ ;
customize. ck Out Manage Share & Track Copies Workflows Tags and Motes
| New Document Library ame Modified Modified By my
_D Create a place to store and
share documents. xhibit B & rew 7/7/2010 3:03 PM WEBSI02010%Administrator
New Site | . [ . R
° Create a site for a team or whibit C &2 Hew /2010 3:03 FM WEBSIC2010%Administrate
project. DK License Agreement & new /2010 3:03 PM WEBSIOZ2010%Administrator

More Options...
Create other types of pages, b
listz, libraries, and sites.

View All Site Content
View all libraries and lists in
this site.

Edit in ShareFoint Designer
E.Y  Create or edit lists, pages, and
workflows, or adjust settings.
Site Permissions
Give people access to this site.

Site Settings
Access all settings for this site.
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3. Inthe Site Settings window select option "Site collection features"

1
¢ Favarites 7] Site Settings J T v B) - [ f v Page - Safety~ Took - @~

System Account -

Site Actions -

Team Discussion Site Collection Web Analytics Al

Site Administration reports
— Regicnal settings
4/ Recycle Bin Site libraries and lists Reporting Services
[B) Al Site Content r slerts Manage Shared Schedules
Reporting Services Site
arch and offline availability Settings

E d workspaces

W attings

Related Links scope settings
Term store management

Site Collection
Administration

=Search settings

Search scopes

ywords

arch keywords
Search site promotion
and demotion

Search user context
Recycle bin

Site collection features MIF
Site hierarchy

e collection audit settings

dit log reperts

Portal site connection

Site collection pol
Content type pul ing
=harePoint Designer Settings
visusl Upgrade

Halm cabrinar

T e nrarmat R LT, R

4. In the list of installed features find "Websio Scanner Plug-in 2010 Professional" and press
"Activate".

If you can't find this option go on to the next step.

Site Actions ~

s about information in Mic reFoint Foundation

. | Search Server Web Parts
| g Activate |

This feature uploads all web parts required for Search Center.

SharePoint 2007 Workflows
Activate |

Aggregated set of out-of-box workflow features provided by SharePoint 2007

SharePoint Server Enterprise Site Collection features

| s | Features such as InfoPath Forms Services, io Services, Access Services, and Deactivate | Active

Excel Services Application, included in the SharePoint Server Enterprise License.

SharePoint Server Publishing Infrastructure

Activate |

SharePoint Server Standard Site Collection features

| " Features such as user profiles and search, included in the SharePoint Server Deactivate

Standard License.
Three-state workflow
Deactivate | Active
Use this workflow to track items in a list -
Websio QuickLaunch 2010 Deactivate |
Websio Scanner Plug-in 2010 Professional Activate | -

Workflows
Deactivate |

Aggregated set of out-of-box worldflow features provided by SharePuoint.
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5. Open SharePoint 2010 Central Administration, select "System Settings" and click on

"Manage farm solutions" link.

{.;' System Settings - Windows Internet Explorer

@:——: - I | http: //sps2010: 13530 /systemsettings. aspx

ij Favorites | 1’5 @ Suggested Sites * @ | Web Slice Gallery ~

j g || = I Bing pelibs

.| System Settings @ = - B E%J - Page - Safety - Tools - '@"

WEBSIOZ2010V\administrator «

Site Actions ~ i IO

-

S : o . =
& SﬁrePomtzom Central Administration » System Settings N4 ~
ILike It Tags &
Maotes
o

Cjnt.ra.'l . UI Servers
Administration # Manage servers in this farm | Manage services on server

Application Management

System Settings
Monitoring

Backup and Restore
Security

Upgrade and Migration

General Application
Settings

Configuration Wizards

" E-Mail and Text Messages (SMS)

Configure ocutgoing e-mail settings
Configure incoming e-mail settings
Configure mobile account

Farm Management
Configure alternate access mappings

Manage farm features | Manage farm solutions -‘\\\
Manage user solutions | Configure privacy options

Configure cross-firewall access zone

Ijavascript: R

Websio Information Solutions Ltd
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6. Inthe Solution Management window check that websioscannerplugin2010.wsp has status

"Deployed".

(_;' Solution Management - Windows Internet Explorer

@\-‘: ! vl ) http://sps2010: 13530/_adminSolutions.aspx j *2 || X I Bing P

{3 Favorites | 'i.}; @ Suggested Sites ~ @ | Web Slice Gallery -

.| Solution Management & B - Léé - Page - Safety - Tools ~ '@'*

WEBSI102010\administrator -

Site Actions ~ gl

| »

7. Inthe Solution Properties window press "Deploy solution". Wait until status "Deployed" will
appear. Deployment process may take few minutes.

8. Returntostep 1.

Websio Information Solutions Ltd
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P gﬁarePointmm Central Administration » Solution Management (2 Ly
’ This page has a list of the Solutions in the farm. Ilikelt  Tags &
Motes
Central
Administration Name Status Deployed To
Application Management demosclution.wsp Deployed Globally deployed.
System Settings ribbondemao.wsp Deployed Globally deployed.
Manitoring websioquicklaunch2010.wsp Deployed http://sps2010/,...
Backup and Restors websioscannerplugin2010.wsp Deployed Globally deployed.
Security
Upgrade and Migration
General Application
Settings
Configuration Wizards
[ [ [7 Trusted sites | Protected Mode: Off [Fa~ [# 100% -

=
“
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After click on the "Scan Document" button nothing happenes

1. Test your scanner. Scan from the Windows Paint (Important! Scan from Paint, not from
the program supplied with your scanner). If you cannot scan from Paint, read your
scanner documentation how to configure your scanner properly.

2. For Windows 7/8 disable Internet Explorer Protected Mode for your SharePoint portal

zone
3. Ensure that the default 32-bit Internet Explorer is in use

4. Assign your site to the Local Intranet (preferred) or Trusted Site Security Zone

After click on the "Scan Document"” the eDocStation freezes or error is
displayed.

1. Probably your scanner does not support selected scan protocol. Open the eDocSation

settings and change scan protocol in the “Scan settings”.

After scan on the Windows 8 GDI+ error is displayed.

1. Close all instances of the Internet Explorer. Launch Internet Explorer once as
Administrator (right-click on the IE icon and select “Run as Administrator”).
2. Open SharePoint portal, scan document and save it.

3. Next time you can launch IE in the common mode.

Another problem

Ask for our support! Write to: support@websio.com
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This Software uses:
iTextSharp library v.4.1.6 (http://sourceforge.net/projects/itextsharp/) distributed under Lesser General

1.

Public License (LGPL) to convert images to PDF
2. Tesseract OCR engine library (http://code.google.com/p/tesseract-ocr/) distributed under Apache License
2.0 for Optical Character Recognition (OCR)

3.  AForge.NET Framework published under LGPL v3 license.
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